Introduction to Microsoft Access XP
Access is the database management system in Microsoft Office. A database is an organized collection of
facts about a particular subject. An address book or a library’s card catalog is a database. An Access database
is the electronic equivalent of a manual database. It lets you organize the facts and provides a way for you to
maintain the data electronically.
A database management system provides functions to store, search, filter, query, and report on the data in a
database. Modern database management systems provide database objects that are tools you need to store,
maintain, search, analyze, and report on the data in your database.
Launching the Program
Open Access by going to Start, All Programs,
Microsoft Office, Microsoft Access. Access opens,
displaying the task pane on the right hand side. Click
the Blank Database link.
Working in the Database Window
The Database window (figure below) allows you to
work with all the objects in the database. The types of
database objects are shown in the Objects Bar on the
left side of the window. The list of all objects of that
type will be listed in the Objects List on the right side
of the window.

Database Window Toolbar

Objects Bar

Object List

Database Objects:
• Tables are collections of data about a specific topic, such as orders, products or addresses. They contain
rows, referred to as records, and columns, referred to as fields.
• Queries provide a way to view, change and analyze data.
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•
•
•
•
•

Forms provide a customized view for working with tables. Forms make the database more interactive
by utilizing text-input boxes and command buttons.
Reports provide organized, professional views of data from queries or tables.
Pages create data access web pages.
Macros provide an automated way to perform common database actions, including opening/closing
forms and using command buttons to print or save.
Modules use the Visual Basic programming language to perform advanced tasks.

Before creating a database, you should plan the fields you want to include in each datasheet or table—that is,
what type of information the database should contain and how you wish it organized. Plan your database on
paper first by writing field names that would best identify the information entered as field contents. Any time
you alter information in a record in any database object, it is automatically changed in other objects containing
that record.

Creating a Database File
When Access is opened, a task pane appears on the right side of the screen, giving you several options. To
begin a new database, click Blank Access database link; if you have already created a database, under Open a
file, click on the database file listed or click More files to browse for the desired file.

When you choose Blank Database, the first thing the program does is open File NewDatabase window forcing
you to create a file name and location where you will save the new database. Once that is complete, the
Database Window opens, ready for you to begin creating your new database.

Creating Database using the Database Template
Before creating a database from scratch, we will use the wizard to create one using sample data in Access.
1. Under New from template, click General Template, Database Tab, Contact Management. Click
OK.
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2. Name the file (Practice) and select the place you want to save it (My Documents) then click the Create
button.
3. The next screen summarizes the database’s functions. Click the Next button to continue.

4. This screen shows the Tables in the
database and the fields that are
included in each table. The wizard we
selected requires some fields in these
tables. The italicized fields are optional
fields you may wish to add. Do not
change fields for this class. Click the
Next button to continue.

5. Select the style for the screen display. Chick each style and note the effect in the preview. Select the
International style for this activity. Click Next
6. Select the Casual style for reports. Click Next
7. Enter Contact Management as the title of this database if it does not appear in the title window already.
Do NOT check that you want a picture on all reports. Click Next
8. On the next screen, click the YES box when asked if you want to start the database. Click Finish
9. At the Database wizard main switchboard screen, select Enter/View Contacts

10. The following window opens in Form View. Form view allows you to enter information easier than in
the datasheet view.
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11. To move from one field to the next, hit the enter key or the tab key. There is no need to save after the
entry--the information is saved automatically as soon as you move to a new field. The only time you
need to use the Save function is if you make design changes to tables, forms, or reports. The program
will automatically prompt you to save your changes. Enter the information from the table below into the
correct fields in the form. Click Add a New Record button after the last field is entered (Work Phone)
to create a new record.
Last
Name

First
Name

Address

City

State/Province

Postal
Code

Country

Buchanan

Steven

14 Garrett Hill

London

UK

Davolio

Daniel

507 20th Ave. E. Apt 2A

Seattle

WA

98122

USA

Fuller

Andrew

908 W. Captial Way

Tacoma

WA

98401

USA

Hill

Steven

14 Garrett Hill

London

Leverling

Janet

Kirkland

WA

98033

USA

Peacock

Laura

722 Moss Bay Blvd.
4110 Old Redmond
Blvd.

Redmond

WA

98052

USA

UK

Work Phone
(715) 5548486
(504) 5559857
(504) 5559482
(715) 5548486
(504) 5553412
(504) 5558122

12. After the data is entered, on the standard toolbar, click the down arrow next to the Design View icon.
Select Datasheet View. Scroll and note that the several fields have not been used.
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13. Switch to Design view on the Standard Toolbar. Select the Work Extension field by clicking once on
the right entry box and delete it by using the delete key on the keyboard. Delete all fields that were not
used in the same manner except CONTACTID. This is the Primary key set by the program. Each
record MUST have a unique number--the primary key is this number.
14. Adjust the placement of the field names on the design screen by clicking on the desired fields. Move the
mouse pointer changes to the hand shape, moving field by left clicking and dragging to new location.
15. Switch to Form View and check that the field is no longer displayed. Click the Save icon on the
Standard Toolbar to save changes (because you have made changes in the design of the form).
16. Return to the Form View and enter another record to your database. Enter the following record:
Davolio

Jean

507 20th Ave. E. Apt 2A

Seattle

WA

98122

USA

(504) 5559857

Sort Records
A quick sort option is available on the Records menu in either the Datasheet or Form view. When Records,
Sort is selected, the choice of ascending or descending is provided. The sort may also be accomplished using
the ascending or descending sort buttons, on the Table Datasheet view and Form view toolbars. Note: The
selected column(s) will be TEMPORARILY sorted. The sorted records can be printed at this time. This sort
can become permanent only by saving the Table or form.
Several columns of data may be sorted at one time, and each column’s sort order can be determined
independently to provide a sort on multiple criteria. A datasheet may be sorted on multiple criteria by selecting
two or more adjacent columns at the same time, and them sorting them all either in ascending or descending
order. The leftmost column is sorted first. In Form view, you can only sort on one field at a time.
Page 5 of 16

To undo the sort, select Records, Remove Filter/Sort.
Example:
1. Select Datasheet view on the standard toolbar or by selecting it under the View menu.
2. Select the Last Name field by clicking once on the field title.
3. Execute a sort by either using the toolbar or using Sort under the Records menu.
4. Select the Address and City field names. Execute a sort in ascending order. Notice that the first character
rather than the street name sorted the addresses.
Now select the City field and the State field. Execute a sort. Click the save icon on the toolbar.

Filter Records
There are times when the most efficient way to gather information from a datasheet or form is to isolate (filter
out) only those records that satisfy a specific set of conditions into a subset.
The Standard toolbar contains two options that filter out a set of records:
(1) Filter by Selection
(2) Filter by Form

Filter by Form and by Selection options can also be accessed using the Filter option under the Records menu.
Filter by Selection and Filter by Form are two easy ways to filter records in Form View or Datasheet view.
Filter by Selection is used when you wish to select one item or part of an item in a field and filter for all
occurrences of that item. For example, if you wish to select all persons that lived in Seattle, you would select
one “Seattle” item from the CITY field and click on Filter by Selection. All persons living in Seattle would be
isolated in the table format. Go back to record menu and select Remove Filter/Sort to remove filter.
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Filter by Form can be used in Datasheet or Form view when you want to set filters for data in more than one
field or if you cannot find the selection you need for a filter by selection. It allows you to enter the desired data
into a sample form and to set “or” criteria using the Or tab at the bottom of the window.

DATASHEET VIEW
FORM VIEW

In Access, you can use the shortcut menus to make filtering even easier. If you right-click in a form or
datasheet field, then select Filter For:, you can type in the exact value you are searching for in that field. You
can also use Filter by Selection as discussed previously.
In the Contacts datasheet, practice completing a filter for City “Seattle”. Right click in the City field, type
“Seattle” and press the enter key after typing Seattle in the Filter For: Box.

Creating a Query
Creating queries is one of the most important and frequently performed database tasks. Before creating a query,
it is important to understand some fundamental query concepts.
Queries enable the user to view, select, change, and analyze data in a variety of different ways. Queries can
also be used as the source of data for forms and reports. Queries enable users to ask questions about the data in
tables. The collection of records that answer a query is called a recordset. The recordset is a special set of
records that may contain data from one or more tables.
Access provides the user with several methods of creating queries.
•

A filter can be saved as a query.

•

The Query Wizard can be used.

•

A query can be created in Design view.
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Database Window

Using a Query Wizard to Create a Simple Select Query
A Query Wizard prompts the user for information and then creates a query based on the answers given. If you
are working in one of the Database Objects, click the Database Window button on the toolbar to return to the
Database window.
1. In the Database window, click on Queries under the Objects Bar.
2. Double-click on Create query by using wizard.
3. Choose the table that will be used as
the basis for the query. Choose
Table: Contacts.
4. Select the desired fields under the
heading Available Fields to include
in the query. Click the > button to
place item under heading Selected
Fields. Choose Contact ID, Last
Name, First Name, Address, City,
State, and Postal code. Choose
Next.
5. Leave the default of Detail on the
next window and click the Next
button.
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6. Specify a title for the query or leave the suggested title as is.

7. Choose an option to tell Access what to do with the query after it is created. Choose Finish.
8. Observe the information that you specified in your query.
9. Save the query as Contacts Query by clicking on the Save icon button on the toolbar. Close the query
window.
10. Complete another query using the same Contacts Table.
11. Choose the fields: First Name, Last Name, and Work Phone.
12. Save query as Phone Information.
13. Open Contacts Table. Add yourself to the Table. Now open the Phone Information query. You will see
that the new information is now part of the query.
14. When you select Queries under the Objects Bar in your database you will see the queries that you have
saved. They can then be printed or used later to create reports.

Creating and Using Basic Forms
Forms provide a different way of viewing Access tables. They are also designed to automate standard paper
forms. A well-designed form significantly reduces the risk of data entry errors in the table. In the Datasheet
view, records appear in a standard, columnar format. In Form view, fields and records can be displayed in a
variety of ways.
Page 9 of 16

Access provides several ways to create forms.
• The New button creates an AutoForm
•

The Form Wizard creates forms

•

Design view is used to create forms

Create a form by using AutoForm
AutoForm creates a form that displays all fields and records in the underlying table or query. If the record
source you select has related tables or queries, the form will also include all the fields and records from those
record sources.
1. In the Database window, click Forms under the Objects Bar.
2. Click the New button on the Database window toolbar or click the New Object button on the toolbar
and choose Form.
3. In the New Form dialog box, click one of the following wizards:
o

AutoForm: Columnar Each field appears on a separate line with a label to its left.

o

AutoForm: Tabular The fields in each record appear on one line, with the labels displayed
once at the top of the form.

o

AutoForm: Datasheet The fields in each record appear in row-and-column format, with one
record in each row and one field in each column. The field names appear at the top of each
column.

4. Choose the table or query that contains the data you want to base your form on by using the drop down
arrow. Click OK. The form opens ready for data entry.

Create a form with a wizard
1. In the Database window, click Forms under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Form dialog box, click the wizard that you want to use. A description of the wizard appears
in the left side of the dialog box.
4. Click the name of the table or other record source that includes the data you want to base your form on.
Note You don't need to do this step if you click the Form Wizard option — you can specify the record
source for the form in the wizard.
5. Click OK.
6. If you clicked Form Wizard, Chart Wizard, or PivotTable Wizard in step 3, follow the directions in
the wizard dialog boxes. If you clicked AutoForm: Columnar, AutoForm: Tabular, or AutoForm:
Datasheet, Microsoft Access automatically creates your form.
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If the resulting form doesn't look the way you want, you can change it in Design view.

Create a report using AutoReport
AutoReport creates a report that displays all fields and records in the underlying table or query.
1. In the Database window, click Reports under Objects.
2. Click the New button on the Database window toolbar or click the New Object button on the toolbar
and choose Report.
3. In the New Report dialog box, click one of the following wizards:
o

AutoReport: Columnar. Each field appears on a separate line with a label to its left.

o

AutoReport: Tabular. The fields in each record appear on one line, and the labels print once at
the top of each page.

4. Click the table or query that contains the data you want to base your report on.
5. Click OK.
Microsoft Access applies the last autoformat you used to the report. If you haven't created a report with
a wizard before or haven't used the AutoFormat command on the Format menu, it uses the Standard
autoformat.
Tip You can also create a single-column report based on an open table or query or on the table or query
selected in the Database window. Click the arrow next to the New Object button on the toolbar, and then click
AutoReport. Reports created with this method don't have a report header and footer or a page header and
footer.

Create a report with a wizard
1. In the Database window, click Reports under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Report dialog box, click the wizard that you want to use. A description of the wizard
appears in the left side of the dialog box.
4. Click the table or query that contains the data you want to base your report on.
Note Microsoft Access uses this table or query as the default record source for the report. However,
you can change the record source in the wizard and select fields from other tables and queries.
5. Click OK.
6. If you clicked Report Wizard, Chart Wizard, or Label Wizard in step 3, follow the directions in the
wizard dialog boxes. If you click AutoReport: Tabular or AutoReport: Columnar, Microsoft Access
automatically creates your report.
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If the resulting report doesn't look the way you want, you can change it in Design view.

Printing a Report
Although reports may be previewed on the screen, they are usually designed to be printed. Before printing a
report for the first time, the margins, page orientation, and other page setup options should be specified in the
Page Setup Dialog Box under the File Menu. After setting up the page setup, the Print command under the
File menu is used to send a report to the printer.

Create mailing and other types of labels
1. In the Database window, click Reports

.

2. Click the New button on the Database window toolbar.
3. In the New Report dialog box, click Label Wizard.
4. Click the table or query that contains the data for the labels, and then click OK.
5. Follow the directions in the wizard dialog boxes.
If the resulting label report doesn't look the way you want, you can delete the report and run the Label
Wizard again.

Create a table using a wizard
1. Open Microsoft Access, click Blank Database.
2. Specify a name and location for the database and click Create.
3. Choose Create table Using Wizard.
4. The next window offers several different headings in several different tables. Choose the headings you
want for your table and click the “>” to add them to the new table. (If you need to rename a default
heading, click the Rename button at the bottom of the window). Click Next button when all fields are
selected.
5. In the next window, name your table. Leave the default of “Yes, let wizard set the primary key” unless
you have a field in your table that can be a primary key (such as ID number). The primary key must be
unique for each record added. Click Next button, then Finish button.
The table opens in datasheet view, ready for data entry. You can now create a form if you prefer to enter
data in the form view.

Create a table by entering data
1. Open Microsoft Access, click Blank Database.
2. Specify a name and location for the database and click Create.
3. Choose Create table entering data. The table opens in datasheet view:
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4. Right click on each column and choose Rename Column. Type the new heading (name) for each field.
5. Once all columns are renamed you may begin entering data. At this point, you can also create a form to
enter the data. Before you can create a form or close the table, you will be asked to name the table, then
the following window will open:

6. Click Yes. Your table is now saved in the Database Window.

About getting help while you work
If you need help while you work, you can use the following resources:
Screen Tips
If you aren't sure what a specific command or button does, or if you want to know more about an option in a
dialog box, you can get help through ScreenTips. ScreenTips show information about different elements on the
screen.
ScreenTips can be accessed three ways:
•

For help with a menu command, toolbar button, or screen region, on the Help menu, click What's This?
and then click the area for which you want help.
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•

For help with a dialog box option, click the question mark
option.

•

To see the name of a toolbar button, rest the pointer over the button; the name appears.

in the dialog box, and then click the

Ask a Question box
To quickly access Help, use the Ask a Question box
questions in this box to quickly find the answers you need.

on the menu bar. You can type

The Office Assistant
The Office Assistant automatically provides Help topics and tips on tasks you perform as you work — before
you even ask a question. For example, when you create a query in Microsoft Access, the Assistant can
automatically display topics for helping you create the query.
You can customize the Assistant, and decide if you want it to automatically display tips, messages, and alerts,
make sounds, move when it's in the way, and guess a Help topic that it thinks you may need.
You can also type a question and the Assistant will display a list of possible matching topics.
Office Assistant tips
The Assistant also displays tips on how to use the features in the Microsoft Office programs more effectively.
The light bulb
next to the Assistant displays the tip when it's clicked.
Note In some Microsoft Office XP programs, the Assistant tips are turned off by default.
The different Office Assistants
You can also select a different Assistant that appeals to you and matches the way you work. You can decide
how you want the Assistant to work for you. For example, if you prefer using the keyboard to using the mouse,
you can have the Assistant display tips on shortcut keys. Because the Assistant is shared by all Office programs,
any options you change will apply to the Assistant in your other Office programs as well.
Select a different Office Assistant
1. Click the Office Assistant.
If the Assistant isn't visible, click Show the Office Assistant on the Help menu.
2. In the Assistant balloon, click Options.
If the Assistant balloon isn't visible, click the Assistant.
3. Click the Gallery tab, and then click Back or Next until you see the Assistant you want.
You can turn the Office Assistant completely off. If you do, Help will be accessed through the Help window.
Using the Help Window
On the Help menu, click Microsoft Access Help.
If the Contents, Answer Wizard, and Index tabs aren't visible, click Show

.
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In the Help window, do the following:
•

Click the Contents tab to view the table of contents for Help.

•

Click the Answer Wizard tab to type a question about the Microsoft Office program in which you are
working. Type the words you want to search for, and click Search.

•

Click the Index tab to search for specific words or phrases, or choose from a list of keywords.

Help on the World Wide Web
You can connect to the Microsoft Office Web site and other Microsoft Web sites directly from any Microsoft
Office program by using the Office on the Web command on the Help menu. For example, you can access
technical resources and download free product enhancements — all without leaving the Office program you're
working in.
Also, if you find a Help topic that begins with "Web", the Office Web article will appear in your Help window,
and you will have the option to open it in a larger browser window.

☺Use the Help menu to find out how to delete a record in datasheet or form view.
ACCESS TOPICS IN MICROSOFT TUTORIAL
The following topics on the Microsoft Office XP Interactive Tutorial will review and further explain the skills
covered in this Access handout. Double click the arrow next to Working with Microsoft Access to open the
Access menu.
Double click the arrow on Creating and Formatting Tables. The following subtopics will review skills
introduced in this class:
Creating Table
Working with Records
Formatting and Printing
Double click the arrow on Organizing Information. The following subtopics will review skills introduced in
this class:
Sorting Data
Filtering Data
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OFFICE XP TUTORIAL
All new computers purchased through LPSS bid quote now come with Windows XP and Office XP. As part of
the LPSS image, we have purchased an Office XP interactive tutorial that is an excellent resource which
introduces the Office XP suite. Located on the desktop is a shortcut icon to the interactive tutorial. To open the
tutorial, double click the shortcut icon on the desktop.

The following window will open:

By clicking Courses, you
can choose text only or
text and audio tutorial.

The blue arrow pointing
right indicates other
topics are listed. Double
click and the arrow
points down, indicating
topic has been opened.
A red arrow indicates a
tutorial in progress.
Once a tutorial has been
completed, a green check
will appear next to the
topic.

Topics can be selected in any order. You will see a blue diamond ( ) next to each topic. To open a topic and
begin the tutorial on that topic, you must hold down the <Ctrl> key and double click on the topic. PopUp Stopper is installed on all new machines and will prevent the new window from opening unless you hold
down the <Ctrl> key. If you have chosen Audio & Text tutorial, the tutorial begins automatically. Follow the
directions to finish the tutorial. At the bottom of the tutorial window, you will see the length of topic. To exit
the tutorial, on the bottom toolbar, click the stop button.
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